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Start 

Installation 

CDROM Version 

1. Insert disk labeled “BacklightFly Installation Disk” into CDROM drive. 

2. Open the CDROM folder. 

3. Execute BacklightFlySetup.msi (double click on the BacklightFlySetup.msi file), and follow the installation 

wizard
1
. 

 

 

 

                                                 
1 If your system doesn’t have .Net Framework 2.0 installed, Setup will ask you to download and install it from our website. 

If you don’t have Internet connection available, please answer no and close setup program, then execute dotnetfx.exe to 

install it. Once it is done, re-execute BacklightSetup.msi and finish the installation. 
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4. Finished. 
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Download Version 

1. Execute BacklightFlySetup.msi (double click on the BacklightFlySetup.msi file) and follow the installation 

wizard
2
. 

 

 

 

 

 

                                                 
2 If your system doesn’t have .Net Framework 2.0 installed, Setup will ask you to download and install it from our website. 

Once you finish .Net Framework 2.0 installation, please re-execute BacklightFlySetup.msi and finish the installation. 
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2. Finished. 
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Registration 

 

 

 

Registration can be divided into two steps as shown in above picture. 

 

Step1: 

 Save Hardware Key to a file and email it to support@febees.com . 

 Once we receive your file, we will produce an unlock license file and send it back to you. 

 

Step2: 

 Load the License file that you receive from us and click OK. 

 Registration Finished. 

 

mailto:support@febees.com
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Please note that BacklightFly will close itself automatically after your click OK button.  You will need to start it again 

from Start menu,  
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BacklightFly 1-2-3 

Do you know that it only takes three steps to make BacklightFly works for you? 

1. Enter your density distribution. 

2. Output dot patterns using one of built-on output methods. 

3. Review output dot patterns. 

 

One of the design goals of BacklightFly is to eliminate the unnecessary complex. Instead of providing you tons of 

features, in which none can deliver precise density output, we focus, and only, on precise density outputs.  
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Overview 

 

 
 

Layer Window: The layers list. First item is always Layer Container, others are layers. 

Property Window: The properties of selected design or layer in the Layer Window. 

Density Chart Window: Display the density chart of active dot. 

Design Window: For density values editing. Several view modes are available to toggle. 

 Design View: Foreground: design lines; Background: current density displays as grayscale. 

 Loaded Image View: Foreground: design lines; Background: loaded image. 

 Design Tiles Loaded Image View: Upper: design view; Bottom: loaded image view. 

 CCD View: This view will be redesigned. 

 Overlay View: This view will be redesigned. 

 Preview View: Preview the current density as grayscale. 
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Figure 1 Design View 

 

 

 

Figure 2 Design tiles loaded image view 
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Figure 3 Loaded image view 

 

Figure 4 CCD view 
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Figure 5 Overlay View 

 

 

Figure 6 Preview View 

 

Shortcut keys: 

 Space: Toggle selected/unselected of current density dot. 

 Left Double Click: Toggle selected/unselected of current density dot. 

 Left Click and Hold + Drag: Toggle selected/unselected of multiple density dots. 

Ctrl + Left Click and Hold + Drag: Select a section and open the section density chart. 
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Layers 

Layer Container 

 

 

Composition Method: 

Composition Method Effects 

Cumulate cumulate densities of the same spot of layers 

Average averages densities of the same spot of layers 

Minimum get the minimum density of the same spot of layers 

Maximum get the maximum density of the same spot of layers 

 

Dots: 

The density table after following processing (in order): 

 Composition of multiple layers. 
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 Overall Density Multiplier. 

 Overall Density Adder 

Height:  The height of light guide plate. 

Width: The width of light guide plate. 

Overall Density Adder: Adding a density value (positive or minus) to the entire density result. 

Overall Density Multiplier: Multiplying a factor to the entire density result. 

Name: The name of the design. 

Description: The description of the design. 
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Layer 

 

 

Dots: The density table of the layer. 

Negative: If true, the entire density table will be treated as negative values when doing layers composition. 

X: The X position relates to Layer Container. 

Y: The Y position relates to Layer Container. 

Width: The width of the layer. 

Height: The height of the layer. 

Name: The name of the layer. 

Description: The description of the layer.  
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Density and Design Lines 

Density Adjusting Methods 

Density values adjusting can be done using following methods: 

 Menu: Layout->Adjust Density Values 

 Menu: Layout->Adjust Density Gradiently 

 Menu: Layout->Open Density Editor 

 Modify density value in Current Density Dot Window 

 

 

Figure 7 Menu: Layout->Adjust Density Values 

 

 

Figure 8 Menu: Layout->Open Density Editor 
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Figure 9 Density Editor 

 

 

Figure 10Yellow: selected dots 

 

 

Figure 11 Active Dot Window 
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Add, Modify and Remove Design Lines 

 

Layout design lines can be done using following methods: 

 Menu: Layout->Re-Layout Design Lines Evenly. 

 Menu: Layout->Add Design Lines. 

 Menu: Layout->Remove Design Lines. 

 Menu: Layout->Open Density Editor. 

 

 

 

Figure 12 Menu: Layout->Re-Layout Design Lines Evenly 

 

 

Figure 13 Menu: Layout->Add Design Lines 

 

 

Figure 14 Menu: Layout->Remove Design Lines 
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Figure 15 Menu: Layout->Open Density Editor 
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Density Dots 

 

 

A density dot is created at each interaction of design lines and removed automatically when a design lines is removed. 

Properties of an active dot can be observed at the Active Dot Window. 

 

Figure 16 - Active dot window 
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Density Editor 

 

 

 

 

Gray Cells: Horizontal cells are the position of X design lines. Vertical cells are the position of Y design lines. The unit 

is percentage (0-1) or absolute (mm). For more about unit, please refer to topic: Unit. 

Yellow/White Cells: The target density values. Users can specify target density values here. The unit is percentage (0- 1) 

or grayscale (0 – 255). For more about unit, please refer to topic: Unit. 

Red Cells: The selected dots in design window will be highlighted as red color. 

Validate: validates if the input values are correct. 

Shortcut keys: 

 Ctrl + C: Copy 

 Ctrl + V: Paste 
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Adjust Density 

 

  

This method is used to adjust density by adding a value or multiplying a factor. 
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Adjust Density Gradiently 

 

 

This method is used to adjust density while smoothing the density changing speed in nearby areas. 
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X/Y Section Density Editor 

 

  

This method is used to adjust density by dragging selected density dots. 

Usage: 

 Mouse down and hold on Density Dot. 

 Drag the density dot up or down or Up/Down key to adjust density value. 

If you wish to drag multiple dots at a time: 

 Left or Right key to navigate through density dots. 

 Space to select or de-select density dots. 

 Mouse Drag (while mouse down and hold) or Up/Down key to adjust density values. 
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Move Design Lines 

Move design lines feature allow you to relocate design position without changing the current density distribution too 

much. 

This feature can be accessed through Layout->Move Design Lines and Layout->Open Design Lines Editor… 

 

 

 

 

Figure 17 - Allow you to edit current X design line position. 

 

 

Figure 18 - Allow you to edit current Y design line position. 

 

 

Figure 19 - Allow you to edit all design lines at once. 
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Mask 

Mask feature allow you to cut or mask off shapes and text on the output results.  This feature is located at the property 

window of design file. 

 

 

    Figure 20 - a Mask applied grayscale image. 

 

 

Figure 21 - Click on the design file to bring up property window 

 

 

 

Figure 22 - Property window of design file. 

 

 

Figure 23 - Masks input table. 

 

 

 

Mask Field Description 

Field Description 

Shape Type Diamond, Rectangle, Ellipse (also Circle), Text 
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X, Y For Diamond, Rectangle and Ellipse, these two fields are the center 

location of the shape. 

For Text, these are the left-top corner position. 

Width, Height The dimension of shapes.  For Text, these fields are ignored. 

Result Density Must be “Min”.  Currently, only Min is supported. 

Font Size Font size in points. 

Angle Rotate angle. 
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Options 

Unit 

 

 

The Unit settings can be changed at Menu: Tools->Options->Unit. 

 

Density Unit: density unit can be either percentage (0 – 1) or grayscale (0 – 255).  When under percentage unit, higher 

values indicate bigger shapes or darker grayscale. When under grayscale unit, higher values represent smaller shapes or 

lighter grayscale. 

 

Dimension Unit: dimension unit can be either percentage (0 – 1) or absolute (mm). When under percentage unit, the 

values represent the proportional position in the layer.  For example: if the layer’s width is 90mm.  X=0.3 represents the 

X position at X = 27mm. 
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Language 

 

The Language settings can be changed at Menu: Tools->Options->Language. 

 

Supported User Interface Languages: 

 English (International) 

 Chinese (Taiwan)  



 

 

 

 31 / 65  

   

 

Default Values 

 

The Default Values settings can be changed at Menu: Tools->Options->Default Values. 

 

If you wish to change the default values of new designs, here is the place.  
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Folders 

 

The Folders settings can be changed at Menu: Tools->Options->Folders. 

 

Enable Enforced Save Folder: 

If enabled, the save folder will be restricted to the specified folder and its subfolders.  
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Output Methods 

Grayscale Output 

 

File->Output->Grayscale Output 

 

Output density distribution using grayscale colors and densities (0-1) are normalized to grayscale values (0-255). 
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Settings 

 
 

General 

 

Format: The format of output files. 

Width: The width of output files. 

Height: The height of output files. 

DPI:  Pixels per inch. This option is only available when Format is Image. The actual image size is calculated as:  

Image Size (Pixels) = (Width / 25.4 * DPI) x (Height / 25.4 * DPI) 

 

How density values relate to grayscale values: When density value is 1, grayscale value will be 0. When density value 

is 0, grayscale value will be 1. For Density values between 0 and 1, the grayscale values will be proportional.  
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Array Output 

 

File->Output->Array Output 

 

Array output uses modal-based algorithms to generate output results. The following rules can be expected at all time: 

 Output density (area coverage rate) will be consistent with design density at all time. 

 Output result is repeatable since it is modal-based. 
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Settings 

 

 

General 

 

Format: The format of output files. 

Width: The width of output files.  

Height: The height of output files. 

Shape: The type of output shape. 

Shape Area Factor: This factor is used to calculate the actual area of a shape. The value will be adjusted based on the 

shape type you selected automatically. In some cases, you may need to adjust this factor to get a different effect. Shape 

area is calculated as below: 

  ShapeArea = ShapeAreaFactor * ShapeSize * ShapeSize 

DPI:  Pixels per inch. This option is only available when Format is Image. The actual image size is calculated as:  

Image Size (Pixels) = (Width / 25.4 * DPI) x (Height / 25.4 * DPI) 
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Options 

Coordinate Rotate Angle: rotate the output coordinate by specified angle. 

 

Layout Method 

 

Fixed Pitch Method 

Layout shapes using fixed pitch method. Both X and Y pitches can be specified.  

 

X Pitch: X pitch value. 

 

Y Pitch Variation Method 

 Vary Y Pitch Automatically 

Allow output shape size controlled in reasonable ranges (i.e. to avoid over-size shapes or tiny shapes).  

Ideal Min Shape Size:  Specify the ideal minimum shape size of output shapes. 

Ideal Max Shape Size:  Specify the ideal maximum shape size of output shapes. 

Please note that if the ideal min shape size or max shape size does not have a mathematical solution, the actual 

output shape size will still exceeded the ranges in order to maintain precise output density. 

 Fixed Y Pitch 

Traditional fixed pitch and vary shape size method.  

Y Pitch: specify Y pitch. 

 Enable Auto Y Pitch Adjusting: turn on or off auto Y pitch adjusting. 

Amplification: controls the maximum degree of Y pitch adjusting. 

Period: controls how many rows to complete a full amplification. The formula is defined as: 

Rows to complete a cycle = 360 / Period 
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Definition of X and Y Pitch 

 

Fixed Size Method 

Layout shapes using fixed size method.  

Shape Size: the size of outputting shapes. 

Enable Y Axis Line Mode: turn this option on to disable the Y direction vibration. 
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Density Output 

 

 

File->Output->Density Output 

Density output is designed to output the current density distribution in grid form.   
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Settings 

 

 
 

Width: number of columns to output. 

Height: number of rows to output. 

Fraction Digits: maximum fraction digits. 
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Output File Formats 

BacklightFly supports multiple output formats. If the current formats do not meet your needs, please contact us. 

Supported Formats: 

 DXF 

 EPS 

 Gerber 

 Image 

 Standard Laser 

 Standard Laser w/ Origin Offset 

 LightTools(Text) 

 SPEOS (Text) 

 Text Coordinate  

 TracePro(Text) 
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Materials 

 Quick Start Guide 

 Example – 3 LED LG 
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Quick Start Guide 

 

Quick Start for BackLight Fly

2009/05/18

Image (100mmX100mm) from Michael Balzer (internet)

Same pitch 400X400um (febees) Same size 300um (febees)

 

Software overview

Design area

XY profile
information

Layer setting

Layer’s 

information

Dot information
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Width

Height

Design

Name

Layer name : Main

(Auto created)

Create a new design file

 

Choose suitable mode to design and check

Design mode: 

editable in active layer

Active layer gray level result

CCD mode: 

editable in active layer

Composite color result

Gray level mode: 

Non-editable

Composite final result
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Width

(11)

Height

(11)

Total 121 Dots

Total 121 Dots

Modify Dots

Modify dot mesh

 

Select dots in special area 

Select all dots Unselect all dots
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Input density table directly or paste from excel 

Density table Design PreView

Output : fix size or pitch

 

Import from external graph file (mesh mode)

Click

X,Y resolution

Browse

Import file Design PreView

Output : fix size or pitch
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layer

Project

Operation of multi-layers

Final multiplier factor

Final offset factor

False as “-”

True as “+”

Design output=Operation  of multi-layers(+/-layer 1….+/-layer n)

*Final multiplier factor + Final offset factor

Composite layers

Click for density table

 

Choose right output 

format and output size

Property of same size output

File/Output/Array

Choose dot pattern and 

right shape area factor

Square  SAF=1

Circle SAF=0.785

Rotate

Define Square width
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X

Y

Property of same pitch output

Define X

Control size

X

Y

Define Y

Disable

Angle=60
0

Enable

Angle=60
0

~90
0

 

Same design for different outputs

Same pitch Same pitch +Rotate 

X pitch +Rotate +Size control Same size
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Data comparison

Select Luminous image

Hold mouse to select

active area

Click OK

1

2 3
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Example – 3 LED LGP 

Example -3LEDS 

Materials:

Light Guide

36mm

4
4

m
m

LGM dimension
Position and number 

of Design lines

Typical density profile

2mm12mm

LED location Luminance result

 

Procedure:

Open BackLight fly 

and key in 

dimension 

Copy past your 

density table

Density 

table? 

Use gradient tool

Reset design 

number and 

position

Compare 

Luminance data

and add design line 

in hot spot position

Simulation tool or

your own experience

Yes No

Manual modify

then output
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Light source LED X3

Light Guide

36mm

4
4

m
m

Open new project and key in 

X,Y dimension

Open BackLight

fly and key in 

dimension 

 

Modify Dots x,y

Copy data here

Copy past your 

density table
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•Select all dots

•Choose adjust density/Adjust Density Value 

Use gradient tool (ex.  LED side 0.5% far end 65%) 

•Select Adjust by multiple factor to max density

System default=1, so 1*0.65=0.65 

 

•Select all dots

•Choose adjust density/Adjust Density Value Gradiently

•Type -0.6 in adjust value

Choose line align from top

Select proper gradient speed

Use gradient tool (ex.  LED side 0.5% far end 65%) 

Max D=0.65, so top is 0.65-0.645=0.05

Far end =0.65-0=0.65
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You got similar density mapUse gradient tool

 

6.12mm
Define X design lines according 

LED position (total 10)

{ 

0,0.01,0.02,0.1,0.2,0.5,0.8,0.96,

0.98,1

} 

Define Y design lines according 

density profile(total 7)

{

0,0.17,0.33,0.5,0.66,0.82,1

}

Reset design 

number and 

position
6.48mm
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•Set design line X as 10 and Y as 7

•Directly copy coordinator to 

density lines table
Copy Y here

Copy X here

Reset design 

number and 

position

Press “+ “and  “X” to add or delete 

design lines till X=10 and Y=7

 

Manual modify

then output

•Click cross of design lines 

and key in new density in 

active dot window
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Check profile

•Open X/Y section density 

editor to keep density profile 

smooth

Press and move mouse to 

adjust profile 

 

•Set design line X as 10 and Y as 7

•Directly copy coordinator to 

density lines table
Copy Y here

Copy X here

Reset design 

number and 

position

Press “+ “and  “X” to add or delete 

design lines till X=10 and Y=7
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Manual modify

then output

•Click cross of design lines 

and key in new density in 

active dot window

 

Check profile

•Open X/Y section density 

editor to keep density profile 

smooth

Press and move mouse to 

adjust profile 
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•Final Design

 

Compare Luminance data

and add design line in hot 

spot position

Select Luminous image

Hold mouse to select

active area

Click OK

1

2 3
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Compare Luminance data

and add design line in hot 

spot position

•You can add , delete or 

move density lines to align 

bad luminance area.

Add density line functions 

Remove density line functions Move density line functions 
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Compare Luminance data

and add design line in hot 

spot position

Add y line on 0.3

Delete y line on 0.01

 

Compare Luminance data

and add design line in hot 

spot position

•Click cross of design lines 

and key in new density in 

active dot window

The luminance data is copy from internet and this case is just  for reference 

not real data.
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Compare Luminance data

and add design line in hot 

spot position

•Open X/Y section density 

editor to keep density profile 

smooth

Press and move mouse to 

adjust profile 

 

Advance –Tip1 for complex design

•Split your design to multiple layers(LED+Body)

LED

BODY
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Advance –Tip2 put design lines at right place

We normally put lines at center of LED and between in LED layer.

We put more lines is dramatic density change area

 

Advance –Tip3 mask function

•Select main project in Layers window

•Select Masks in property window then click here
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Advance –Tip3 mask function

You can choose Circle, Ellipse ,Text and Diamond as mask shape

mask LED side dots

 

Edit mask table like this

X,Y

Width

H
ei

g
th
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Q & A 

Q1：Why does BackLight FLY use density as design principle？ 

A：Light travelling pattern in LG (light guide) is as total reflection; this, we need dots on the LG to break total 

reflection and let light come out. It is clear that luminance is function of light intensity and dot density; therefore, there 

is no doubt that density is the best way to design LG dots.  

 

Q2：How to design “design lines”？ 

A：We use dots, auto generated at the cross of design lines, to control density distribution. Any times you change dot 

values it will automatically recalculate density map by cubic function to keep density map smooth.  In dramatic density 

change area (LED or edge sides), you need more design lines for better control and less in other area (center of LG) 

 

Q3：How to adjust design lines？ 

A：We provide reset, add, delete, move and edit functions. It should cover all actions of design lines. 

 

Q4：How to change dot value？ 

A：You can change value in active dot window directly. To do this, select dots and do multiple or adjustment or select 

more than 3X3 dots and do a gradient adjustment.  

 

Q5：How to make sure that density profile is smooth？ 

A：Basically, we will smooth the density by cubic function. Cubic function guarantees piece-wise smooth; however, it 

is not enough to satisfy LG design needs. So you still need to check each design line’s profile in the left window (X, Y 

profile) and make them fully smooth.  You can archive this by just adjusting dot value or open profile chart and use 

mouse to drag design line smooth. 

 

Q6：What is the design difference between same pitch and same size output？ 

A：Density design is independent with output format. So you can use same design file for different processes. For 

example you can use same pitch experience (etching) to same size process (laser).   

 

Q7：What is the definition of density？ 
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A：It is very straight forward that density means dots area divide total area (area of coverage). The resolution is relate 

to pitch or size setting in your output. 

 

Q8：How to adjust dot size in same pitch output？ 

A：You can use CAD tool to adjust output DXF file, but it is not necessary. Actually you just need to adjust density and 

system will adjust size according to density. 

 

Q9：What is the dimension unit？ 

A：The dimension unit default is 0~1. You can switch to real design dimension in main menu tools/options.  

 

Q10：When I adjust some dot values, why it sometimes causes other changes？ 

A：We use 5 points to do a piece-wise-smooth curve fitting, when a value is raised or lowered dramatically, it is 

necessary to change the curve style in order to keep up the smooth. To avoid this, you can add some design lines as 

guard band to eliminate this issue.  
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EULA 

License Type 

 

BacklightFly Software Usage Right 

 

(a) Trial License 

After you obtain a copy of this software, you are granted: 

 Install and use the software on your computer until the trial software expires. 

 Make backup of the software. 

  

(b) Single User License 

After you purchase a license of this software, you are granted: 

 The permanent right to use the software. 

 Make backup of the software. 

 

Transfer 

You may not transfer the software license to any third-parties. 

 

Copyright 

 The copyright of the software belongs to Febees Software Inc. 

 

 

 


